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Important Information

Warranty

The GPIB-ENET hardware is warranted against defects in materials and workmanship for a period of two years from 
the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair 
or replace equipment that proves to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming 
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not 
execute programming instructions if National Instruments receives notice of such defects during the warranty period. 
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside 
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs 
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed 
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should 
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages 
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. 
Any action against National Instruments must be brought within one year after the cause of action accrues. National 
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty 
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; 
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, 
or other events outside reasonable control.

Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, 
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without 
the prior written consent of National Instruments Corporation.

Trademarks

CVI™, LabVIEW™, NI-488™, NI-488.2™, and NI-488.2M™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS

National Instruments products are not designed with components and testing intended to ensure a level of reliability 
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical 
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the 
user or application designer. Any use or application of National Instruments products for or involving medical or clinical 
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards, 
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always 
continue to be used when National Instruments products are being used. National Instruments products are NOT intended 
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health 
and safety in medical or clinical treatment.



 

  FCC/DOC Radio Frequency Interference 
Class A Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance 
with the instructions in this manual, may cause interference to radio and television reception. Classification 
requirements are the same for the Federal Communications Commission (FCC) and the Canadian 
Department of Communications (DOC). This equipment has been tested and found to comply with the 
following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense.

Notices to User: Changes or modifications not expressly approved by National Instruments could void 
the user’s authority to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables 
of suitable quality and construction. National Instruments used such cables to test 
this device and provides them for sale to the user. The use of inferior or nonshielded 
interface cables could void the user’s authority to operate the equipment under the 
FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional 
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home 
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government 
Printing Office, Washington, DC 20402.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur 
du Canada.
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About

This

Manual

This manual contains instructions to help you install and configure the 

National Instruments GPIB-ENET hardware and the GPIB software for 

Windows NT.  The NI-488.2M software is intended for use with Microsoft 

Windows NT version 3.51 or higher.

This manual assumes that you are already familiar with Windows NT and 

with TCP/IP networks, and that your computer is connected to an Ethernet 

network. Before you can use the driver software for the GPIB-ENET, you 

must already have a Windows Sockets (WinSock) Interface, version 1.1 or 

higher, installed. Microsoft provides a WinSock Interface with Windows 

NT. Additionally, you can use a WinSock Interface purchased from another 

network vendor.

How to Use the Manual Set

NI-488.2M
User Manual

for Windows 95
and Windows NT

Application
Development
and Examples

Novice
Users

Experienced
Users

NI-488.2M Function
Reference Manual

for Win32
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About This Manual

Use this getting started manual to install and configure your GPIB-ENET 

and the GPIB software for Windows NT.

Use the NI-488.2M User Manual for Windows 95 and Windows NT to learn 

the basics of GPIB and how to develop an application program. You can 

also use the user manual as a reference for debugging information and 

detailed examples.

Use the NI-488.2M Function Reference Manual for Win32 for specific 

NI-488 function and NI-488.2 routine information, such as format, 

parameters, and possible errors.

Organization of This Manual

This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what 

you need to get started and optional equipment you can order, and 

briefly describes the GPIB-ENET hardware and the GPIB software for 

Windows NT.

• Chapter 2, Installation and Configuration, describes how to install and 

configure the GPIB-ENET hardware and the GPIB software for 

Windows NT.

• Chapter 3, Verify the Installation, describes how to verify that the 

hardware and software are functioning correctly.

• Chapter 4, Begin to Use the GPIB Software, helps you get started with 

the NI-488.2M software for Windows NT.

• Appendix A, Uninstall the Software, describes how to uninstall the 

GPIB software from Windows NT.

• Appendix B, GPIB-ENET 8-Bit DIP Switch, describes how the 8-bit 

DIP switch on the back panel affects the operation of the GPIB-ENET.

• Appendix C, READY LED Signaling, describes how to interpret the 

READY LED error codes.

• Appendix D, Troubleshooting and Common Questions, describes how 

to troubleshoot problems and answers some common questions.

• Appendix E, Specifications, describes the characteristics of the 

GPIB-ENET and the transfer rates of the NI-488.2M software, along 

with the recommended operating conditions.

• Appendix F, Customer Communication, contains forms you can use to 

request help from National Instruments or to comment on our products 

and manuals.
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About This Manual

• The Glossary contains an alphabetical list and description of terms 

used in this manual, including abbreviations, acronyms, metric 

prefixes, mnemonics, and symbols.

Conventions Used in This Manual

The following conventions are used in this manual.

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options»Substitute 

Fonts directs you to pull down the File menu, select the Page Setup item, 

select Options, and finally select the Substitute Fonts options from the 

last dialog box.

This icon to the left of bold italicized text denotes a note, which alerts you 

to important information.

This icon to the left of bold italicized text denotes a caution, which advises 

you of precautions to take to avoid injury, data loss, or a system crash.

This icon to the left of bold italicized text denotes a warning, which advises 

you of precautions to take to avoid being electrically shocked.

bold Bold text denotes the names of menus, menu items, parameters, dialog 

boxes, dialog box buttons or options, icons, windows, Windows 95 tabs, 

or LEDs.

bold italic Bold italic text denotes a note, caution, or warning.

IEEE 488 and IEEE 488 and IEEE 488.2 refer to the ANSI/IEEE Standard 488.1-1987

IEEE 488.2 and the ANSI/IEEE Standard 488.2-1992, respectively, which define the 

GPIB.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 

to a key concept. 

monospace Text in this font denotes text or characters that you should literally enter 

from the keyboard, sections of code, programming examples, and syntax 

examples. This font is also used for the proper names of disk drives, paths, 

directories, programs, subprograms, subroutines, device names, functions, 

operations, variables, filenames and extensions, and for statements and 

comments taken from programs.

!
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About This Manual

Related Documentation

The following documents contain information that you may find helpful as 

you read this manual.

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface 

for Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats, 

Protocols, and Common Commands

• ANSI/IEEE Standard 802.3-1988, Information Processing Systems, 

Local Area Networks, Part 3

• Microsoft Windows NT System Guide, Microsoft Corporation

Additionally, you might need to refer to the documentation provided by 

your WinSock vendor.

Customer Communication

National Instruments wants to receive your comments on our products 

and manuals. We are interested in the applications you develop with our 

products, and we want to help if you have problems with them. To make it 

easy for you to contact us, this manual contains comment and configuration 

forms for you to complete. These forms are in Appendix F, Customer 

Communication, at the end of this manual.
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Chapter

1Introduction

This chapter explains how to use this manual, lists what you need to get 

started and optional equipment you can order, and briefly describes the 

GPIB-ENET hardware and the GPIB software for Windows NT.
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What You Need to Get Started

Make sure you have all of the following items before you attempt to install 

the hardware and software:

❑ Windows NT version 3.51 or higher installed on your computer

❑ One of the following boxes, which is included in your kit:

GPIB-ENET—10Base-T Version (100-120 VAC)

GPIB-ENET—10Base-T Version (220-240 VAC)

GPIB-ENET—Coax Version (100-120 VAC)

GPIB-ENET—Coax Version (220-240 VAC)

❑ One of the following power cords, which is included in your kit:

U.S.A. standard power cord

Switzerland power cord

Australian power cord

Universal European power cord

North American power cord

U.K. power cord

❑ Ethernet cables, which you can purchase from National Instruments:

Twisted Pair (10Base-T) Cables (1, 5, or 10 m) 

Coax (10Base-2) Cables (1, 5, or 10 m) 

AUI (10Base-5) Cables (1, 5, or 10 m)

❑ The following 3.5 in., high density (1.44 MB) disks, which are 

included in your kit:

GPIB Software for Windows NT and the GPIB-ENET (Setup Disk)

GPIB Software for Windows NT and the GPIB-ENET (NI-488.2M 

Software)

❑ Shielded GPIB Cables1, which you can purchase from National 

Instruments:

Type X1 single-shielded cables (1, 2, or 4 m) 

Type X2 double-shielded cables (1, 2, or 4 m)

1   To meet FCC emission limits for this device, you must use a shielded (Type X1 or X2) GPIB cable. Operating this equipment 

with a non-shielded cable may cause interference to radio and television reception.
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Optional Equipment

Multiple-Computer Software License
A multiple-computer software license is available so that one or more hosts 

on a single physical network can access one or more GPIB-ENET boxes. 

Contact National Instruments for more information regarding the license.

Optional Hardware
Call National Instruments for more information about the following 

optional equipment:

• Serial or parallel bus extender and cables

• Bus expander/isolator

• GPIB mechanical switch

GPIB-ENET Hardware Overview

The GPIB-ENET transparently handles data transfers between an 

Ethernet-based TCP/IP host and the GPIB. With the GPIB-ENET, multiple 

hosts can share a set of GPIB instruments or a single host can control 

several GPIB systems.

The GPIB-ENET converts a computer equipped with an NI-488.2 driver 

and an Ethernet port into a GPIB Talker/Listener/Controller. It is powered 

by an internal 100-120 VAC or 220-240 VAC supply.

The GPIB-ENET comes with all the software and logic required to 

implement the physical and electrical characteristics of all versions of the 

ANSI/IEEE 488 standard, including ANSI/IEEE Standard 488.2-1992, and 

ANSI/IEEE Standard 802.3. The GPIB-ENET interprets and executes 

commands that you send to it over an Ethernet link and performs all 

necessary Ethernet-to-GPIB protocol conversions. For detailed hardware 

specifications, refer to Appendix E, Specifications.

Figure 1-1 shows the seven light-emitting diodes (LEDs) on the 

GPIB-ENET top panel. The LEDs show the current status of the 

GPIB-ENET. Table 1-1 describes each LED.
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Figure 1-1.  GPIB-ENET Top Panel and LEDs

Table 1-1.  LED Descriptions

LED Indication

POWER Indicates that power has been supplied to the unit 

and the ON/OFF switch is in the ON position.

READY Indicates the functional state of the GPIB-ENET. 

When the GPIB-ENET is powered on, this LED 

flashes and then becomes steady when the box is 

ready for operation. Continuous flashing indicates 

that an error has occurred.

TALK Indicates that the GPIB-ENET is configured as a 

GPIB Talker.

LISTEN Indicates that the GPIB-ENET is configured as a 

GPIB Listener.

TRANSMIT Indicates that the GPIB-ENET is transmitting onto 

the Ethernet network.

Ethernet AUI Connector

GPIB Connector

Location of Coax or 10Base-T Connector
(depending on version)
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ETHERNET IEEE 488 Controller
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NI-488.2M Software Overview

The NI-488.2M software includes a native, 32-bit multitasking Windows 

NT driver and supporting utilities.

The NI-488.2M software for Windows NT supports only the GPIB-ENET 

interface. If you need to access other National Instruments GPIB interfaces, 

you must remove the software for the GPIB-ENET and install the software 

for the other type of interface.

The NI-488.2M software, along with the GPIB-ENET hardware, 

transforms a general-purpose PC into a GPIB Talker/Listener/Controller 

with complete communications and bus management capability. The 

NI-488.2M software includes the following components:

• Device driver

• Diagnostic utility

• Configuration utilities

• Interactive control program

• Utilities for software development

• Language interface libraries for Microsoft Visual C/C++ 2.0 or higher, 

Borland C/C++ 4.0 or higher, and Microsoft Visual Basic 4.0 or higher

• Virtual device driver and special DOS and Windows 3 drivers for 

running existing NI-488.2 for DOS and Windows 3 applications under 

Windows NT

• Example programs that use NI-488 functions and NI-488.2 routines

Refer to Appendix E, Specifications, for information about the NI-488.2M 

software transfer rate for the GPIB-ENET.

RECEIVE Indicates that the GPIB-ENET is receiving Ethernet 

network traffic.

LINK Indicates that the GPIB-ENET has detected a 

twisted pair (10Base-T) link. For GPIB-ENET coax 

and AUI options, this LED is not used and remains 

OFF.

Table 1-1.  LED Descriptions (Continued)

LED Indication



Chapter 1 Introduction

GPIB-ENET for Windows NT 1-6 © National Instruments Corporation

Optional Programming Tools

Your kit includes the NI-488.2M software for Windows NT. In addition, 

you can order the LabWindows/CVI or LabVIEW software from National 

Instruments. LabWindows/CVI and LabVIEW include instrument driver 

libraries that make it easier to communicate with your instruments.

LabWindows/CVI is an interactive ANSI C development environment for 

building test and measurement and instrument control systems. It includes 

interactive code-generation tools and a graphical editor for building custom 

user interfaces. It also includes built-in libraries for IEEE 488.2, VXI, 

RS-232 control, and plug-in data acquisition. When you order 

LabWindows/CVI, you also get hundreds of complete instrument drivers, 

which are modular, source-code programs that handle the communication 

with your instrument so that you do not have to learn the programming 

details.

LabVIEW is a complete programming environment that departs from the 

sequential nature of traditional programming languages and features a 

graphical programming environment. It includes all the tools needed for 

instrument control, data acquisition, analysis, and presentation. LabVIEW 

also includes an extensive instrument driver library.

For more information about LabWindows/CVI and LabVIEW, contact 

National Instruments.
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Chapter

2Installation and 
Configuration

This chapter describes how to install and configure the GPIB-ENET 

hardware and the GPIB software for Windows NT.

Install the GPIB Software

Complete the following steps to run the software installation program.

1. Log onto your Windows NT system using the Administrator 

account. The NI-488.2M installation program must have 

Administrator privileges because the program modifies the 

configuration registry of your computer.

2. Insert the GPIB Software for Windows NT and the GPIB-ENET 

(Setup Disk) into an unused drive.

3. Windows NT 3.51: 

Select Run... from the File menu in the Program Manager.

Windows NT 4.0 or higher: 

Select Run... from the Start menu.

Type the following command into the dialog box:

x:\setup

where x is the letter of the drive containing the distribution disk 

(usually a or b). To begin your software installation, click on the 

OK button.

4. The software installation wizard begins with the screen shown in 

Figure 2-1.
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Figure 2-1.  GPIB Software Setup Screen

The setup wizard guides you through the necessary steps to install the 

NI-488.2M software. You may go back and change values where 

appropriate by clicking on the Back button. You can exit the setup 

where appropriate by clicking on the Cancel button.

Install the GPIB-ENET Hardware

Step 1. Determine IP and Ethernet Addresses
The Internet Protocol (IP) address is the address that TCP/IP-based 

networks use to route information to the appropriate network and host. 

When you first install a GPIB-ENET in a network, or if the IP address for 

the GPIB-ENET changes, the GPIB-ENET IP address must be configured. 

1. Note the Ethernet address from the bottom panel label of the 

GPIB-ENET.

The Ethernet address is not the same thing as the IP address. All 

devices on an Ethernet network are assigned a physical address, the 

Ethernet address, so that they can communicate with each other. The 

identification label on the bottom panel of the GPIB-ENET contains 

various information, including the Ethernet address. Figure 2-2 shows 

the GPIB-ENET identification label. 
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Figure 2-2.  GPIB-ENET Bottom Panel Identification Label

2. Contact your network administrator to use the GPIB-ENET on your 

network. Your network administrator assigns a unique, valid IP 

address to your GPIB-ENET. Your network administrator can also tell 

you whether the GPIB-ENET should have its IP address configured by 

a RARP (Reverse Address Resolution Protocol) server, or manually 

using the Assign IP Address utility. The configuration of the IP address 

within the GPIB-ENET will occur in a later step.

Step 2. Configure the NI-488.2M Software Characteristics
The GPIB Configuration utility is an interactive utility you can use to 

examine or modify the configuration of the driver. You must run the GPIB 

Configuration utility before you can use the NI-488.2M software for 

Windows NT. Follow these steps to run the utility:

1. Double-click on the GPIB icon in the Control Panel.

Windows NT 3.51:  

Double-click on the Control Panel icon in the Main group of the 

Program Manager.

Windows NT 4.0 or higher:  

Select Start»Settings»Control Panel.

The GPIB Configuration utility displays a list of all the GPIB 

interfaces and device names. Figure 2-3 shows the GPIB 

Configuration utility screen.

Serial No. XXXXXX

Model:  GPIB-ENET

P/N  1819XX-XX REV X

Ethernet: 00:80:2F:FF:XX:XXMADE IN U.S.A.

XXXV 50-60HZ XXmA FUSE:  XXXmA SLOW   250V

Fuse Information

Current

Ethernet Address

Serial No. XXXXXX

AC Input 

 Voltage
Frequency
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Figure 2-3.  GPIB Configuration Utility

2. Select the GPIB Board name, typically GPIB0, for your GPIB-ENET.

3. Click on the Board Type button.

4. Change the board type from None to GPIB-ENET.

5. Click on the OK button to exit the Board Type dialog box.

6. Click on the Configure button.

7. Enter a Host Name (IP address) for the GPIB-ENET. The previous 

section, Step 1. Determine IP and Ethernet Addresses, describes how 

to obtain an IP Address, or host name, for your GPIB-ENET.

You can make any further changes that you need to in this dialog box. 

Use the online help if you have any questions.

8. Click on the OK button to save your changes. 

9. Click on the OK button to exit the GPIB Configuration dialog box 

and save your changes.

Step 3. Configure the GPIB-ENET Operating Characteristics
The GPIB-ENET has a two-position slide switch that you use to configure 

the network interface connector of the box. The GPIB-ENET also has an 

8-bit DIP switch used to configure the operating characteristics. The 

switches are located on the back panel of the GPIB-ENET, as shown in 

Figure 2-4. 
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Figure 2-4.  GPIB-ENET Back Panel Switches

Configure the Slide Switch
Your GPIB-ENET has two network interface connectors: a 15-pin AUI 

connector and either a 10Base-T Ethernet connector or a coax Ethernet 

connector. Use the slide switch to select which of the two connectors the 

GPIB-ENET uses. The default switch setting is either 10Base-T or coax. 

Figure 2-5 depicts the default setting for the different types of GPIB-ENET 

boxes. 

Figure 2-5.  Default Switch Setting for Ethernet Port Configuration

If you want to use the AUI connector, change the switch setting to match 

the appropriate setting in Figure 2-6.

Figure 2-6.  Switch Setting for AUI Ethernet Port Configuration

10BASE-T AUI

8 7 6 5 4 3 2 1 ON

AUI10BASE-T

AUICOAX

OR

AUI10BASE-T

AUICOAX

OR
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Configure the 8-Bit DIP Switch
The 8-bit DIP switch selects the operating mode of the GPIB-ENET. The 

GPIB-ENET is shipped to you with the DIP switches set for normal 

operation. In normal operating mode, all the switches are in the OFF 

position. Most customers use the GPIB-ENET in this mode. Do not change 

the DIP switch settings unless you run a GPIB-ENET utility that prompts 

you to change them. For information about the 8-bit DIP switch, refer to 

Appendix B, GPIB-ENET 8-Bit DIP Switch.

Step 4. Connect the Cables
If you do not have both a GPIB cable and an Ethernet cable, as listed in the 

What You Need to Get Started section of Chapter 1, Introduction, you can 

purchase them from National Instruments.

1. Connect one end of the Ethernet cable to the GPIB-ENET and securely 

fasten it. Connect the other end of the Ethernet cable to your Ethernet 

network. Be sure to follow all IEEE 802.3 cabling restrictions.

2. Connect one end of the GPIB cable to the GPIB-ENET and tighten the 

thumb screws on the connector. Connect the other end of the GPIB 

cable to your GPIB system. Be sure to follow all IEEE 488.1 cabling 

restrictions and use only shielded GPIB cables.

3. Plug the power cord into an AC outlet of the correct voltage.

Step 5. Switch on Your GPIB-ENET

Caution Operating the GPIB-ENET at any voltage other than the one specified could 

damage the unit.

The GPIB-ENET is shipped from the factory with either a 100-120 VAC or 

220-240 VAC power supply. Before using your GPIB-ENET, verify that the 

voltage rating listed on the bottom of the box matches the voltage that is 

supplied in your area.

IP Address Assignment by a RARP Server
Power on the GPIB-ENET. The POWER LED comes on immediately. The 

READY LED flashes while the GPIB-ENET completes its power-on self 

tests and the IP address is assigned. When the READY LED remains 

steady, the unit is ready to operate and you can configure the software.

!
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The power-on self tests take about 10 seconds to complete, then the box 

obtains its IP address. The time required for the IP address assignment is 

highly dependent on your network and the configuration of your 

GPIB-ENET. If the READY LED does not become steady after one 

minute, refer to the Troubleshooting Hardware Problems section in 

Appendix D, Troubleshooting and Common Questions.

IP Address Assignment Using Assign IP Address
To assign the IP address manually, run the Assign IP Address utility. This 

utility has built-in, context-sensitive online help, available by clicking on 

the Help button.

Follow these instructions to configure and assign an IP address with Assign 

IP Address.

1. To configure the IPassign Protocol, first log in as an Administrator 

and close all applications. Then follow the steps for your version of 

Windows NT.

Windows NT 3.51:

a. Open the Network control panel and click on the Add Software... 

button.

b. In the Add Network Software dialog that appears, choose 

<Other> Requires disk from manufacturer from the 

drop-down list box.

c. Click the Continue button.

d. In the edit control of the Insert Disk dialog box that appears, enter 

the full path of your GPIB installation (such as c:\gpib-nt), and 

click the OK button.

e. After the software is installed, click the Close button of the 

Network control panel applet.

f. After the software configures the network bindings, you are 

prompted to restart your computer for the changes to take effect. 

Restart your computer at this time.

Windows NT 4.0 or higher:

a. Open the Network control panel and click on the Protocols tab.

b. Click the Add... button.

c. In the Select Network Protocol dialog box that appears, click the 

Have Disk... button. 
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d. In the edit control of the Insert Disk dialog box that appears, enter 

the full path of your GPIB software installation (such as 

c:\gpib-nt). 

e. Click on the OK button in the Select OEM Option dialog box.

f. After the software is installed, click the Close button of the 

Network control panel applet.

g. After the software configures the network bindings, you are 

prompted to restart your computer for the changes to take effect. 

Restart your computer at this time.

2. To run Assign IP Address, follow the instructions for your version of 

Windows NT:

Windows NT 3.51:

Double-click on the Assign IP Address icon in the NI-488.2M 

Software for Windows NT group of the Program Manager.

Windows NT 4.0 or higher:

Select the Assign IP Address item under 

Start»Programs»NI-488.2M Software for Windows NT.

Step 6. Configure Subnet Information
Before the GPIB-ENET is fully functional, you should configure it with 

proper subnet information using the Assign Subnet Information utility. 

Your GPIB-ENET may work properly even if you skip this step, but 

National Instruments recommends that you configure information about 

the subnet. This information includes the broadcast IP address and netmask 

to use on the subnet and up to four router IP addresses. The Assign Subnet 

Information utility has built-in, context-sensitive online help, available by 

clicking on the Help button. 

Follow these instructions to run Assign Subnet Information:

Windows NT 3.51:  

Double-click on the Assign Subnet Information icon in the 

NI-488.2M Software for Windows NT group of the Program 

Manager. 

Windows NT 4.0 or higher:  

Select the Assign Subnet Information item under 

Start»Programs»NI-488.2M Software for Windows NT. 
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When you have finished configuring the software and hardware, proceed to 

Chapter 3, Verify the Installation.
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Chapter

3Verify the Installation

This chapter describes how to verify that the hardware and software are 

functioning correctly.

Power-On Self Tests

When you power on your GPIB-ENET, the POWER LED comes on 

immediately. The READY LED flashes while it completes its power-on 

self-tests and is assigned an IP address. When the tests complete 

successfully and the IP address is assigned, the READY LED remains 

steady, indicating that the unit is ready to operate.

The power-on self tests take about 10 seconds to complete. The time 

required for the IP address assignment is highly dependent on your network 

and the configuration of your GPIB-ENET. If the POWER LED does not 

come on immediately or the READY LED continues to flash for more than 

one minute, refer to Appendix D, Troubleshooting and Common 

Questions.

Diagnostic Utility

The Diagnostic utility, installed with your GPIB software, verifies that your 

hardware and software are functioning properly.

Follow these instructions to run the Diagnostic utility:

Windows NT 3.51:  

Double-click on the Diagnostic icon in the NI-488.2M Software for 

Windows NT group of the Program Manager.

Windows NT 4.0 or higher:  

Select the Diagnostic item under Start»Programs»NI-488.2M 

Software for Windows NT.

When you have started the Diagnostic utility, test your GPIB interfaces by 

clicking on the Test All button. If the Diagnostic is successful, it puts a 
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checkmark next to the interface and changes its status from untested to 

passed. If the Diagnostic fails, it puts an X next to the interface, and 

changes its status from untested to failed. Figure 3-1 shows the Diagnostic 

utility after it has tested some GPIB interfaces.

Figure 3-1.  Diagnostic Utility after Testing

You can get details on any tested GPIB interface by selecting the interface 

and clicking on the Details button. For each failed GPIB interface, select it 

and click on the Details button to get a description of the failure. Use that 

information and the information in Appendix D, Troubleshooting and 

Common Questions, to troubleshoot the problem. Troubleshooting 

information is also available in the online help for the Diagnostic utility, 

which you can access by clicking on the Help button.



© National Instruments Corporation 4-1 GPIB-ENET for Windows NT

Chapter

4Begin to Use the 
GPIB Software

This chapter helps you get started with the NI-488.2M software for 

Windows NT.

Introduction to the Win32 Interactive Control Utility

You can use the interactive control utility to enter NI-488 functions and 

NI-488.2 routines interactively and see the values returned by the function 

calls. You can use the utility to do the following:

• Verify GPIB communication with your device quickly and easily.

• Learn the NI-488 functions and NI-488.2 routines before you write 

your application.

• Become familiar with the commands of your device.

• Receive data from your GPIB device.

• Troubleshoot problems with your application.

Follow these instructions to run the Win32 Interactive Control Utility.

Windows NT 3.51: 

Double-click on the Win32 Interactive Control icon in the 

NI-488.2M Software for Windows NT group of the Program 

Manager.

Windows NT 4.0 or later:  

Select the Win32 Interactive Control item under 

Start»Programs»NI-488.2M Software for Windows NT. 

This utility includes extensive online help. For more information about the 

Win32 Interactive Control utility, refer to the NI-488.2M User Manual for 

Windows 95 and Windows NT.
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Introduction to the GPIB Spy Utility

Included with the NI-488.2M software is GPIB Spy, a Win32 utility that 

can be used to monitor NI-488.2M calls made by Win32, Win16, and DOS 

GPIB applications. You can use GPIB Spy to do the following: 

• Capture information about NI-488 functions and NI-488.2M routines 

as they are invoked by your GPIB applications.

• Display captured information, including, but not limited to, input and 

output parameter values, I/O buffer contents, and return values.

• Save, restore, and print captured information.

Follow these instructions to run GPIB Spy:

Windows NT 3.51:  

Double-click on the GPIB Spy icon in the NI-488.2M Software for 

Windows NT group of the Program Manager. 

Windows NT 4.0 or higher:  

Select the GPIB Spy item under Start»Programs»NI-488.2M 

Software for Windows NT. 

For more information about the GPIB Spy utility, refer to Chapter 5, GPIB 

Spy Utility, in the NI-488.2M User Manual for Windows 95 and 

Windows NT, or use the GPIB Spy context-sensitive online help.

General Programming Considerations

As you begin developing your Win32 NI-488.2M application, remember 

the following points:

• For your C/C++ application, you must include the NI-488.2M header 

file in your source code.

• The NI-488.2M software is accessed through the 32-bit DLL, 

gpib-32.dll, either by linking with one of the language interfaces 

provided with the NI-488.2M software, or by using direct DLL entry 

from other programming environments.

• Several sample GPIB applications are included with the NI-488.2M 

software. Use these as a guide for your own application development.

For information about choosing a programming method, developing your 

application, or compiling and linking, refer to the NI-488.2M User Manual 
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for Windows 95 and Windows NT. For detailed information about each 

NI-488 function and NI-488.2 routine, refer to the NI-488.2M Function 

Reference Manual for Win32.

Running Existing DOS and Windows GPIB Applications

You can run existing DOS and Windows GPIB applications under 

Windows NT by using the GPIB Virtual Device Driver, gpib-vdd.dll, 

which is included with your NI-488.2M software.

To run DOS GPIB applications, load the special GPIB device driver 

gpib-nt.com instead of gpib.com, which you normally use with DOS. 

When you install the NI-488.2M software, the installation program copies 

gpib-nt.com into a subdirectory of the GPIB installation directory called 

doswin16. To use gpib-nt.com, you must modify your config.nt file 

to load gpib-nt.com whenever a DOS application runs. The config.nt 

file is located in your winnt\system32 directory, where winnt is your 

Windows NT directory, for example, c:\windows. To load 

gpib-nt.com, add the following line to your config.nt file:

device=path\doswin16\gpib-nt.com

where path is the directory where you installed the GPIB software (the 

default installation directory is c:\gpib-nt).

To run 16-bit Windows GPIB applications, the system uses the special 

GPIB dynamic link library, gpib.dll. When you install the NI-488.2M 

software, the installation program copies gpib.dll into the winnt\

system32 directory, where winnt is your Windows NT directory, for 

example c:\windows. As long as gpib.dll is in your Windows NT 

directory, your system automatically accesses gpib.dll whenever you 

launch a 16-bit Windows GPIB application.
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Appendix

AUninstall the Software

This appendix describes how to uninstall the GPIB software from 

Windows NT.

Removing the IPassign Protocol

If you enabled the National Instruments IPassign Protocol for use with the 

Assign IP Address utility, you need to disable it with the Network Control 

Panel before removing your software. Complete the following steps to 

remove the IPassign Protocol:

Windows NT 3.51: 

1. Double-click on the Control Panel icon in the Main group of the 

Program Manager.

2. Double-click on the Network icon.

3. Select IPassign Protocol in the Installed Network Software list, 

and click on the Remove button.

Windows NT 4.0 or later: 

1. Select Start»Settings»Control Panel.

2. Double-click on the Network icon in the Control Panel to launch the 

Network applet.

3. Select the Services tab to display a list of components available for 

removal.

4. Select National Instruments IPassign Protocol in the Network 

Services list box, and click on the Remove button.
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Uninstalling the GPIB Software

Complete the following steps if you want to remove the NI-488.2M 

software:

Windows NT 3.51: 

1. Double-click on the Uninstall GPIB Software for Windows icon in 

the NI-488.2M Software for Windows NT group of the Program 

Manager.

2. Reboot your system.

Windows NT 4.0 or later: 

1. Select Start»Settings»Control Panel.

2. Double-click on the Add/Remove Programs icon in the Control Panel 

to launch the Add/Remove Programs applet. A dialog box appears, 

listing the software available for removal.

3. Select the NI-488.2M software you want to remove, and click on the 

Add/Remove... button. An uninstall program runs and removes all 

folders, programs, and DLLs associated with the NI-488.2M software. 

4. Reboot your system.
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Figure A-1 shows the results of a successful uninstallation.

Figure A-1.  Uninstallation Results 

If you want to reinstall the hardware and software, refer to Chapter 2, 

Installation and Configuration.
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Appendix

BGPIB-ENET 8-Bit DIP Switch

This appendix describes how the 8-bit DIP switch on the back panel affects 

the operation of the GPIB-ENET.

The 8-bit DIP switch is located on the back panel of the GPIB-ENET, as 

shown in Figure B-1. The DIP switches set the operation mode of the 

GPIB-ENET. The GPIB-ENET is shipped to you with the DIP switches set 

for normal operation mode; all the switches are in the OFF position.

Figure B-1.  GPIB-ENET Back Panel Switches

8-Bit DIP Switch Descriptions

Table B-1 shows the possible configurations of the GPIB-ENET DIP 

switches and what each configuration indicates. The entries in bold italic 

text represent the default settings.

Table B-1.  DIP Switch Settings for Modes of Operation

Switch Position Indication

8 ON Extended Factory Test

OFF Normal Operation

7 ON Modify Mode

OFF Normal Operation

10BASE-T AUI

8 7 6 5 4 3 2 1 ON
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Switch 8 selects the Extended Factory Test mode and should remain OFF 

for normal operating mode. When this switch is ON, the GPIB-ENET 

performs extended tests which require special connections to the GPIB and 

Ethernet ports. Without these connections, the GPIB-ENET cannot pass the 

extended factory tests.

Switch 7 selects the Modify Mode and should remain OFF for normal 

operating mode. The firmware controlling the GPIB-ENET is stored in an 

electrically erasable memory. When this switch is ON, you can reprogram 

the firmware memory from the Ethernet network using the Firmware 

Update utility, or you can modify the subnet information using the Assign 

Subnet Information utility.  Follow these instructions to run one of the 

utilities:

Windows NT 3.51:  

Double-click on the icon for the utility in the NI-488.2M Software 

for Windows NT group of the Program Manager. 

Windows NT 4.0 or higher:  

Select the name of the utility under Start»Programs»NI-488.2M 

Software for Windows NT. 

Both utilities have built-in, context-sensitive online help, available by 

clicking on the Help button within each utility.

Switch 6 indicates how the GPIB-ENET IP address is determined when it 

is powered on. If switch 6 is OFF, the GPIB-ENET expects to receive its 

IP address from the network, and then the GPIB-ENET stores the address 

in nonvolatile memory each time it is powered on. Each time the IP address 

is received from the network, the GPIB-ENET stores it in nonvolatile 

6 ON Use Stored IP Address

OFF Obtain IP Address

5 ON Manual IP Assignment

OFF Automatic IP Assignment

1-4 OFF These switches are reserved 

and should remain OFF.

Table B-1.  DIP Switch Settings for Modes of Operation (Continued)

Switch Position Indication
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memory. If switch 6 is ON, the GPIB-ENET retrieves the IP address that is 

stored in nonvolatile memory.

Switch 5 selects the method by which IP addresses are configured in the 

GPIB-ENET. When switch 5 is OFF, the GPIB-ENET issues RARP 

(Reverse Address Resolution Protocol ) requests each time it is powered on. 

The GPIB-ENET continues to issue RARP requests until a valid RARP 

reply is received. If switch 5 is ON, the GPIB-ENET does not issue RARP 

requests. Note that if switch 6 is ON, the setting of Switch 5 is ignored.

In most networks, the GPIB-ENET can use RARP to have its address 

automatically configured; however, there are some networks which, for 

security or other reasons, do not use RARP. In this case, you must manually 

configure the IP address of the GPIB-ENET by running the Assign IP 

Address utility. This utility has built-in, context-sensitive online help, 

available by clicking the Help button.

Switches 1-4 are reserved for future expansion and should remain OFF.
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Appendix

CREADY LED Signaling

This appendix describes how to interpret the READY LED error codes.

READY LED Overview

The READY LED has several purposes on the GPIB-ENET. When you 

first power on the GPIB-ENET, the READY LED flashes quickly while it 

completes its power-on self-tests. When the tests complete successfully and 

the IP address is assigned from either nonvolatile memory or the network, 

the READY LED remains steady, indicating that the unit is ready to 

operate.

During operation, the READY LED might begin to blink slowly. This 

occurs after running the Firmware Update utility, when the GPIB-ENET 

reports status on the operation. At other times, the READY LED blinks 

slowly to alert you of internal GPIB-ENET errors. For assistance in 

correcting this problem, use this appendix to interpret and record the 

pattern that the READY LED flashes, and then contact National 

Instruments.

Note By recording the READY LED status messages before calling National 

Instruments, you can save yourself time, and the GPIB Product Support 

Department can answer your questions more accurately and efficiently. Do not 

switch off power to your GPIB-ENET before recording the flashing READY LED 

pattern.

READY LED signaling can report up to 100 different errors. The errors are 

numbered from 0 to 99 and are reported through sequences of READY 

LED flashes.
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Step 1. Count the Long Flashes

A 3-second interval, during which the READY LED is OFF, separates 

each repetition of the sequence. The sequence begins with a series of long 

1-second flashes—that is, one second ON, one second OFF. These long 

flashes represent the digit in the tens column. There can be 1 to 10 long 

flashes, which represent digits 0 through 9. For example, one long flash 

represents the digit 0 in the tens column, two long flashes represent the 

digit 1 in the tens column, and 10 long flashes represent the digit 9 in the 

tens column.

Step 2. Count the Short Flashes

The long flashes are followed by shorter flashes; each short flash lasts about 

one-fifth of a second. These short flashes represent the digit in the ones 

column. Again, there can be 1 to 10 flashes, which represent the digits 0 

through 9. For example, one short flash represents the digit 0 in the ones 

column, two short flashes represent the digit 1 in the ones column, and 

10 short flashes represent a 9 in the ones column.

Using this method, the READY LED flashes the following sequence to 

represent status message 11:

<three seconds OFF> <two long flashes> <two short flashes> <three 

seconds OFF>. . .

The READY LED flashes the following sequence to represent status 

message 30:

<three seconds OFF> <four long flashes> <one short flash> <three seconds 

OFF>. . .

Step 3. Record Your Status Code Number

When you have computed your status code number, record it on the 

GPIB-ENET Hardware and Software Configuration Form in 

Appendix F, Customer Communication, before calling National 

Instruments.
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Table C-1 lists some examples of the long and short flashes and the status 

codes they report.

Table C-1.  Sample READY LED Signals and the Corresponding 

Status Code Numbers

Number of Long 

Flashes

Number of Short 

Flashes

Corresponding Status 

Code Number

1 1 00

2 1 10

5 3 42

1 8 07

3 4 23

10 10 99
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Appendix

DTroubleshooting and 
Common Questions

This appendix describes how to troubleshoot problems and answers some 

common questions.

Troubleshooting Hardware Problems

Warning The GPIB-ENET contains circuitry that operates with hazardous voltages. Do not 

attempt to open and service the box. Refer servicing to qualified personnel.

• Verify that all cables are securely connected to the GPIB-ENET.

• Verify that the GPIB-ENET is powered on. If the unit is powered on 

and plugged into an outlet of the proper voltage, yet you see no LED 

activity, check the condition of the fuse.

Warning For continued protection against fire, replace the fuse with only the same type and 

rating of fuse. See Appendix E, Specifications, for fuse specifications.

• Verify that the Ethernet port configuration slide switch is set to the 

correct Ethernet port. Refer to the Configure the Slide Switch section 

of Chapter 2, Installation and Configuration, for more information.

• Verify that the DIP switch settings are configured properly for your 

setup. Refer to Appendix B, GPIB-ENET 8-Bit DIP Switch, for more 

information.

• Verify with the system administrator that your IP address is valid and 

that the network is set up to recognize the IP address properly.

• If you configured the IP address manually using the Assign IP Address 

utility, verify that you have correctly followed the steps in the online 

help for that utility.

• If the READY LED continues to flash for more than one minute, you 

have a problem with your setup. If the READY LED is flashing 

quickly, the GPIB-ENET is unable to obtain its IP address from the 

network. In this case, check with your network administrator to verify 

your IP address and make sure that you recorded the Ethernet address 

correctly. If the READY LED is blinking slowly, the GPIB-ENET has 

an internal error. In this case, refer to Appendix C, READY LED 
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Signaling, to determine which error is being reported and contact 

National Instruments.

Troubleshooting EDVR Error Conditions

In some cases, calls to NI-488 functions or NI-488.2 routines may return 

with the ERR bit set in ibsta and the value EDVR in iberr. The value 

stored in ibcntl is useful in troubleshooting the error condition.

EDVR Error Condition with ibcntl Set to 0xE028002C (-534249428)
If a call is made with a board number that is within the range of allowed 

board numbers (typically 0 to 31), but which has not been assigned to a 

GPIB interface, an EDVR error condition occurs with ibcntl set to 

0xE028002C. You can assign a board number to a GPIB interface by 

configuring the NI-488.2M software and selecting an interface name. Refer 

to Step 2. Configure the NI-488.2M Software Characteristics in Chapter 2, 

Installation and Configuration, for information about how to configure the 

NI-488.2M software.

EDVR Error Condition with ibcntl Set to 0xE0140025 (-535560155)
If a call is made with a board number that is not within the range of allowed 

board numbers (typically 0 to 31), an EDVR error condition occurs with 

ibcntl set to 0xE0140025.

EDVR Error Condition with ibcntl Set to 0xE0140035 (-535560139)
If a call is made with a device name that is not listed in the logical device 

templates that are part of the GPIB Configuration utility, an EDVR error 

condition occurs with ibcntl set to 0xE0140035.

EDVR Error Conditions with ibcntl in the Range from 0xE1002710 
(-520083696) to 0xE1002EE0 (-520081696)

These errors are returned from the WinSock Interface. The lower 16 bits of 

ibcntl specify the actual WinSock Interface error. Refer to your WinSock 

Interface documentation for more information about the specific error.

EDVR Error Condition with ibcntl Set to 0xE1000054 (-520093612)
You are attempting to communicate with a GPIB-ENET that does not have 

a host name (IP address) specified in the GPIB Configuration utility. Refer 

to Step 2. Configure the NI-488.2M Software Characteristics, in Chapter 2, 
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Installation and Configuration, for information about how to configure the 

NI-488.2M software.

EDVR Error Condition with ibcntl Set to 0xE100004E (-520093618)
You are attempting to communicate with a GPIB-ENET that has a firmware 

revision that is incompatible with the current driver. Use the Firmware 

Update utility to upgrade the firmware to a compatible version. Follow 

these steps to run the utility:

Windows NT 3.51:  

Double-click on the Firmware Update icon in the NI-488.2M 

Software for Windows NT group of the Program Manager. 

Windows NT 4.0 or higher:  

Select Firmware Update under Start»Programs»NI-488.2M 

Software for Windows NT. 

This utility has built-in, context-sensitive online help, available by clicking 

on the Help button within the utility.

Troubleshooting Diagnostic Utility Failures

The following sections explain common error messages generated by the 

Diagnostic utility.

Missing Software Components
This error occurs if the software components that are necessary for the 

NI-488.2M software for Windows NT to function correctly are not present 

in the system. If you encounter this problem, reinstall the NI-488.2M 

software for Windows NT and run the Diagnostic utility again.

No GPIB Interfaces Present
This error occurs if there are no GPIB interfaces physically present in the 

system or there is a resource conflict with the interfaces that are installed. 

If you encounter this problem, use the GPIB Configuration utility to 

examine the installed GPIB interfaces and the resources assigned to each. 

Then, run the Diagnostic utility again.
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To access this information in the GPIB Configuration utility, complete the 

following steps:

1. Double-click on the GPIB icon in the Control Panel.

Windows NT 3.51:  

Double-click on the Control Panel icon in the Main group of the 

Program Manager.

Windows NT 4.0 or higher:  

Select Start»Settings»Control Panel.

2. Click on the Interface Type button and verify that the type of GPIB 

interface listed for each logical board name is correct. Click on the OK 

button to return to the main dialog box.

3. Double-click on each board name and verify that the hardware settings 

displayed in the dialog box match your actual hardware settings.

GPIB-ENET Problem Encountered
This error occurs if an unknown problem is encountered while attempting 

to access the GPIB-ENET. There are several possible reasons that you 

might encounter this problem:

• The GPIB-ENET might not be properly configured. Refer to the Install 

the GPIB-ENET Hardware section in Chapter 2, Installation and 

Configuration, for detailed instructions.

• The Host Name field in the GPIB Configuration utility might be 

incorrect for the GPIB-ENET. Run the GPIB Configuration utility, 

as described under Step 2. Configure the NI-488.2M Software 

Characteristics in Chapter 2, Installation and Configuration, to verify 

that the IP address value has been correctly specified.

• The GPIB-ENET might not be correctly configured for your network. 

Try to ping your GPIB-ENET to make sure it is recognizable on the 

network. The ping utility is a network utility that sends a packet to a 

device/host on the network, then waits for it to be echoed back, which 

indicates an active device/host. Your WinSock provider probably came 

with a ping utility. Find the directory where ping.exe is installed and 

type in the following command:

ping IPaddress 

where IPaddress is the IP address assigned to your GPIB-ENET. If 

your network administrator assigned you a hostname also, you can 

type in ping hostname instead. If ping is unable to communicate 

with your GPIB-ENET and your network administrator tells you that 

your IP address is valid, contact National Instruments.
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Missing WinSock Support
WinSock support is enabled and configured in the Network Control Panel 

applet. To configure WinSock support, perform the following steps.

Windows NT 3.51:

1. Double-click on the Control Panel icon in the Main group of the 

Program Manager.

2. Double-click on the Network icon.

3. In the Network Settings dialog box that appears, click on the Add 

Software... button.

4. In the Add Network Software dialog box that appears, select TCP/IP 

Protocol and related components item from the Network Software 

drop-down list.

Windows NT 4.0 or higher:

1. Double-click on the Network icon under Start»Settings»Control 

Panel.

2. In the Network dialog box that appears, select the Protocols tab.

3. On the Protocols tab, click on the Add... button.

4. In the Select Network Protocol dialog box that appears, select 

TCP/IP Protocol.

After you have properly installed and configured WinSock support, run the 

Diagnostic utility again.

GPIB Cables Need To Be Disconnected
This error occurs if you have any GPIB cables connected to the GPIB 

interface. Disconnect all GPIB cables and run the Diagnostic utility again.

GPIB Software Problem Encountered
This error occurs if the Diagnostic utility detects that it is unable to 

communicate correctly with the GPIB hardware using the installed GPIB 

software. If you get this error, shut down your computer, restart it, and run 

the Diagnostic utility again. If the problem persists, try reinstalling the 

GPIB software for Windows NT.



Appendix D Troubleshooting and Common Questions

GPIB-ENET for Windows NT D-6 © National Instruments Corporation

Unknown Problem Encountered
This error occurs if an unknown problem is encountered while trying to 

execute the Diagnostic utility. If you encounter this problem, shut down 

your computer, restart it, and run the Diagnostic utility again. If the 

problem persists, try reinstalling the GPIB software for Windows NT.

Common Questions

I do not currently have a WinSock provider installed. What do I need 

to do to install a WinSock provider?

Before you can use the driver software for the GPIB-ENET, you must have 

a WinSock interface, version 1.1 or higher, installed. You can install a 

WinSock interface from Microsoft or another network vendor. Refer to the 

Missing WinSock Support section of this appendix for information about 

how to install and configure WinSock support.

My driver is not communicating with the GPIB-ENET. What should 

I do? 

Make sure that the GPIB-ENET is configured properly. Refer to Chapter 2, 

Installation and Configuration.

My I/O worked with a board interface, but it times out when I use the 

GPIB-ENET interface. What should I do? 

Network communication is slower than straight cable communication. 

You might need to raise the default Timeout value using the GPIB 

Configuration utility. Refer to Step 2. Configure the NI-488.2M Software 

Characteristics in Chapter 2, Installation and Configuration, for 

information about the GPIB Configuration utility.

I powered off my GPIB-ENET before recording the flashing READY 

LED pattern. What should I do? 

Try to duplicate the error before calling National Instruments for 

assistance. Recording the READY LED pattern is not critical to the 

operation of your GPIB-ENET, but it saves you time and helps National 

Instruments to diagnose the problem quickly and accurately.
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How can I determine which version of the GPIB software I have 

installed?

Run the Diagnostic utility, as follows:

Windows NT version 3.51:  

Start the Diagnostic utility by double-clicking on the Diagnostic icon 

in the NI-488.2M Software for Windows NT group of the Program 

Manager.

Windows NT version 4.0 or later:

Start the Diagnostic utility by choosing the Diagnostic item under 

Start»Programs»NI-488.2M Software for Windows NT.

A banner at the bottom of the Diagnostic utility window displays the 

version of the GPIB software that is installed.

Which GPIB interfaces does version 1.0 of the GPIB software for 

Windows NT and the GPIB-ENET support?

This version of the GPIB software supports only the GPIB-ENET.

What do I do if the Diagnostic utility fails with an error?

Refer to the troubleshooting sections of this appendix for specific 

information about what might cause the Diagnostic utility to fail. If you 

have already completed the troubleshooting steps, fill out the forms in 

Appendix F, Customer Communication, and contact National Instruments.

How many GPIB interfaces can I configure for use with my GPIB 

software for Windows NT? 

The GPIB software for Windows NT can be configured to communicate 

with up to 32 GPIB interfaces.

How many devices can I configure for use with my GPIB software for 

Windows NT? 

The GPIB software for Windows NT provides a total of 1,024 logical 

devices for applications to use. The default number of devices is 96. The 

maximum number of physical devices you should connect to a single GPIB 

interface is 14, or fewer, depending on your system configuration.



Appendix D Troubleshooting and Common Questions

GPIB-ENET for Windows NT D-8 © National Instruments Corporation

When should I use the Win32 Interactive Control utility?

You can use the Win32 Interactive Control utility to test and verify 

instrument communication, troubleshoot problems, and develop your 

application program. For more information, refer to Chapter 4, Begin to 

Use the GPIB Software.

How do I use an NI-488.2M language interface?

For information about using NI-488.2M language interfaces, refer to 

Chapter 3, Developing Your Application, in the NI-488.2M User Manual 

for Windows 95 and Windows NT.

How do I communicate with my instrument over the GPIB? 

Refer to the documentation that came from the instrument manufacturer. 

The command sequences you use are totally dependent on the specific 

instrument. The documentation for each instrument should include the 

GPIB commands you need to communicate with it. In most cases, NI-488 

device-level calls are sufficient for communicating with instruments. Refer 

to Chapter 3, Developing Your Application, in the NI-488.2M User Manual 

for Windows 95 and Windows NT, for more information.

Can I use the NI-488 and NI-488.2 calls together in the same 

application? 

Yes, you can mix NI-488 functions and NI-488.2 routines.

What can I do to check for errors in my GPIB application? 

Examine the value of ibsta after each NI-488 or NI-488.2 call. If a call 

fails, the ERR bit of ibsta is set and an error code is stored in iberr. 

For more information about global status variables, refer to Chapter 3, 

Developing Your Application, in the NI-488.2M User Manual for 

Windows 95 and Windows NT.

Why does the uninstall program leave some components installed?

The uninstall program removes only items that the installation program 

installed. If you add anything to a directory that the installation program 

created, the uninstall program does not delete that directory, because the 

directory is not empty after the uninstallation. You will need to remove any 

remaining components yourself.
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What information should I have before I call National Instruments?

When you call National Instruments, you should have all of the information 

filled out on the GPIB-ENET Hardware and Software Configuration Form 

in Appendix F, Customer Communication.
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Appendix

ESpecifications

This appendix describes the characteristics of the GPIB-ENET and the 

transfer rates of the NI-488.2M software, along with the recommended 

operating conditions.

Hardware Characteristics

Table E-1.  Electrical Characteristics

Characteristic Specification

Power Supply Unit 100-120 VAC ± 10%, 50-60 Hz or

220-240 VAC ± 10%, 50-60 Hz

Maximum Current 

Requirement

100-120 VAC 110 mA or

220-240 VAC 55 mA

Fuse Rating 

and Type

100-120 VAC 300 mA, UL/CSA approved

or 

220-240 VAC 500 mA, IEC approved

Table E-2.  Environmental Characteristics

Characteristic Specification

Operating 

Temperature 0° to 40° C

Storage 

Temperature −20° to 70° C

Relative Humidity 10% to 90% noncondensing conditions

EMI FCC Class A Verified
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Software Transfer Rate

Table E-3.  Physical Characteristics

Characteristic Specification

Overall Case Size 

(Dimensions)

8.89 by 14.35 by 4.11 cm

(3.5 by 5.65 by 1.62 in.)

Case Material All metal enclosure

Weight 0.41 kg (0.9 lb)

Table E-4.  NI-488.2M Software Transfer Rate for the GPIB-ENET

Transfer Method Maximum GPIB Transfer Rate

3-wire (IEEE 488) 74 kbytes/s*

* Actual speed may vary considerably from speed shown because of system and 

instrumentation capabilities.
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Appendix

FCustomer Communication

For your convenience, this appendix contains forms to help you gather the information necessary 

to help us solve your technical problems and a form you can use to comment on the product 

documentation. When you contact us, we need the information on the Technical Support Form and 

the configuration form, if your manual contains one, about your system configuration to answer your 

questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to quickly 

provide the information you need. Our electronic services include a bulletin board service, an FTP site, 

a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first try the 

electronic support systems. If the information available on these systems does not answer your 

questions, we offer fax and telephone support through our technical support centers, which are staffed 

by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of files 

and documents to answer most common customer questions. From these sites, you can also download 

the latest instrument drivers, updates, and example programs. For recorded instructions on how to use 

the bulletin board and FTP services and for BBS automated information, call 512 795 6990. You can 

access these services at:

United States: 512 794 5422

Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use 

your Internet address, such as joesmith@anywhere.com, as your password. The support files and 

documents are located in the /support directories.
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a wide 

range of technical information. You can access Fax-on-Demand from a touch-tone telephone at 

512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mail at the 

Internet address listed below. Remember to include your name, address, and phone number so we can 

contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical 

support number for your country. If there is no National Instruments office in your country, contact 

the source from which you purchased your software to obtain support.

Country Telephone Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Brazil 011 288 3336 011 288 8528

Canada (Ontario) 905 785 0085 905 785 0086

Canada (Québec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 09 725 725 11 09 725 725 55

France 01 48 14 24 24 01 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

Israel 03 6120092 03 6120095

Italy 02 413091 02 41309215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico 5 520 2635 5 520 3282

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain 91 640 0085 91 640 0533

Sweden 08 730 49 70 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 377 1200 02 737 4644

United Kingdom 01635 523545 01635 523154

United States 512 795 8248 512 794 5678



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and use 

the completed copy of this form as a reference for your current configuration. Completing this form 

accurately before contacting National Instruments for technical support helps our applications 

engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, 

include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) __________________________________________

Computer brand____________ Model ___________________ Processor _____________________

Operating system (include version number) ____________________________________________

Clock speed ______MHz   RAM _____MB Display adapter __________________________

Mouse ___yes   ___no     Other adapters installed _______________________________________

Hard disk capacity _____MB Brand_________________________________________________

Instruments used _________________________________________________________________

_______________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration ___________________________________________________________________

National Instruments software product ___________________  Version  _____________________

Configuration ___________________________________________________________________

The problem is: __________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

List any error messages: ___________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

The following steps reproduce the problem: ___________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________



GPIB-ENET Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item. 

Complete a new copy of this form each time you revise your software or hardware configuration, and 

use this form as a reference for your current configuration. Completing this form accurately before 

contacting National Instruments for technical support helps our applications engineers answer your 

questions more efficiently.

National Instruments Products

GPIB-ENET hardware revision _____________________________________________________

10Base-T or Coax version _________________________________________________________

AC input voltage (100-120 V or 220-240 V) ___________________________________________

DIP switch settings _______________________________________________________________

Ethernet port configuration slide switch setting _________________________________________

IP address ______________________________________________________________________

READY LED signaling status code __________________________________________________

GPIB software for GPIB-ENET and Windows NT version number on disks __________________

Programming language interface version ______________________________________________

Diagnostic utility results ___________________________________________________________

Other Products

Programming Environment Information

Programming language ___________________________________________________________

Compiler vendor _________________________________________________________________

Compiler version ________________________________________________________________

Application Information

DOS application _________________________________________________________________

Win16 application _______________________________________________________________

Win32 application _______________________________________________________________

If Win16 or Win32, method of accessing DLL (link with language interface or direct entry:) 

_______________________________________________________________________________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products. 

This information helps us provide quality products to meet your needs.

Title: Getting Started with Your GPIB-ENET and the GPIB Software for Windows NT

Edition Date: April 1998

Part Number: 321368B-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

E-Mail Address __________________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) _______________________________

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation

6504 Bridge Point Parkway 512 794 5678

Austin, Texas 78730-5039
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Glossary

Prefix Meanings Value

n- nano- 10–9

µ- micro- 10– 6

m- milli- 10–3

° degrees

% percent

A amperes

AC alternating current

ANSI American National Standards Institute

AUI attachment unit interface

C Celsius

CSA Canadian Standards Association

DIP dual inline package

EEPROM Electrically Erasable Programmable Read Only Memory

EMI electromagnetic interference

FCC Federal Communications Commission

g grams

GPIB General Purpose Interface Bus

Hz hertz

IBIC Interactive Bus Interactive Control

IEC International Electrotechnical Commission

IEEE Institute of Electrical and Electronic Engineers
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Glossary

in. inches

IP Internet Protocol

lb pounds

LED light-emitting diode

m meters

MB megabytes of memory

RAM random-access memory

RARP Reverse Address Resolution Protocol

s seconds

TCP Transmission Control Protocol

UL Underwriters Laboratories

V volts

VAC volts alternating current
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